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SOFTWARE LICENSE AGREEMENT

IMPORTANT: BY OPENING THE SEALED DISK PACKAGE CONTAINING THE SOFT-
WARE MEDIA, YOU ARE AGREEING TO BE BOUND BY THE TERMS AND CONDI-
TIONS OF THE LICENSE AGREEMENT (“AGREEMENT”).  THIS AGREEMENT 
CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU (“LICENSEE”) AND 
MAGELLAN CORPORATION. (“LICENSOR”).  CAREFULLY READ THE AGREEMENT 
AND IF YOU DO NOT AGREE WITH THE TERMS, RETURN THIS UNOPENED DISK 
PACKAGE AND THE ACCOMPANYING ITEMS TO THE PLACE WHERE YOU OB-
TAINED THEM FOR A FULL REFUND.

LICENSE.  LICENSOR grants to you a limited, non-exclusive, non-transferable, personal
cense (“License”) to (i) install and operate the copy of the computer program contained in
package (“Program”) in machine acceptable form only on a single computer (one central 
processing unit and associated monitor and keyboard) and (ii) make one archival copy of
Program for use with the same computer.  LICENSOR and its third-party suppliers retain
rights to the Program not expressly granted in this Agreement.

OWNERSHIP OF PROGRAMS AND COPIES.  This License is not a sale of the original 
Program or any copies.  LICENSOR and its third-party suppliers retain the ownership of t
Program and all copyrights and other proprietary rights therein, and all subsequent copies
Program made by you, regardless of the form in which the copies may exist.  The Program
the accompanying manuals (“Documentation”) are copyrighted works of authorship and co
valuable trade secret and confidential information proprietary to LICENSOR and its third-p
suppliers.  You agree to exercise reasonable efforts to protect the proprietary interests of
LICENSOR and its third-party suppliers in the Program and Documentation and maintain 
in strict confidence.

USER RESTRICTIONS.  The Program is provided for use in your internal commercial busi
operations and must remain at all times upon a single computer owned or leased by you.
may physically transfer the Program from one computer to another provided that the Progr
operated only on one computer at a time.  You may not operate the Program in a time-sha
service bureau operation or rent, lease, sublease, sell, assign, pledge, transfer, transmit 
electronically or otherwise dispose of the Program or Documentation, on a temporary or 
permanent basis, without the prior written consent of LICENSOR.  You agree not to trans
modify, adapt, disassemble, decompile, or reverse engineer the Program, or create deriv
works of the Program or Documentation or any portion thereof.

TERMINATION.  The License is effective until terminated.  The License will terminate witho
notice from LICENSOR if you fail to comply with any provisions of this Agreement.  Upon
termination, you must cease all use of the Program and Documentation and return tem, a
copies thereof, to LICENSOR.

GENERAL.  This Agreement shall be governed by and construed in accordance with the 
of the State of California and the United States without regard to conflict of laws provision
thereof and without regard to the United Nations Convention on Contracts for the Internat
Sale of Goods.
iii
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DISCLAIMER OF WARRANTIES AND LIMITATION OF 
LIABILITY

LICENSOR AND ITS THIRD-PARTY SUPPLIERS MAKE NO WARRANTIES OR 
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE PROGRAM, MEDIA, 
DOCUMENTATION, RESULTS OR ACCURACY OF DATA AND HEREBY EXPRESSLY 
DISCLAIM ANY WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE AND NONFRINGEMENT.  LICENSOR AND ITS THIRD-
PARTY SUPPLIERS DO NOT WARRANT THE PROGRAM WILL MEET YOUR 
REQUIREMENTS OR THAT ITS OPERATION WILL BE UNINTERRUPTED OR ERROR-
FREE.

LICENSOR, its third-party suppliers, or anyone involved in the creation or deliver of the 
Program or Documentation to you shall have no liability to you or any third-party for special, 
incidental, indirect or consequential damages (including, but not limited to, loss of profits or 
savings, downtime, damage to or replacement of equipment or property, or recover or 
replacement of programs or data) arising from claims based in warranty, contract, tort (including 
negligence), strict liability, or otherwise even if LICENSOR or its third-party suppliers have 
been advised of the possibility of such claim or damages.  The liability of LICENSOR and its 
third-party suppliers for direct damages shall not exceed the actual amount paid for this Program 
License.

Some states do not allow the exclusion of limitation of implied warranties or liability for 
incidental or consequential damages, so the above limitations or exclusions may not apply to 
you.

U.S. GOVERNMENT RESTRICTED RIGHTS

The Program and Documentation are provided with RESTRICTIVE RIGHTS.  Use, duplication, 
or disclosure by the Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of 
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subdivision 9(C)(1) and (2) of the Commercial Computer Software - Restricted Rights 48 CFR 
52.227.19, as applicable. 

Should you have any questions concerning the License Agreement or the Limited Warranties 
and Limitation of Liability, please contact in writing:  Ashtech, 1170 Kifer Road, Sunnyvale, 
CA 94086
Mission Planning User’s Guide
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The Mission Planning for Windows (MPW) program allows you to plan a project that uses 
the Global Positioning System (GPS) and/or the Russian GLONASS system. It gives you 
the ability to view the visibility and availability of the satellite constellations, and to 
determine the dilution of precision using these constellations for any location in the world. 
All the tools are available for entering sites of interest, creating a list of sites, entering site-
unique obstructions and determining the best time to make your measurements.

Ideally, you want to plan your project so you have a good window, meaning that there are 
enough satellites available and in good enough locations in the sky for you to obtain good 
results. Now that GPS is operational and GLONASS satellites are available, it is rare that 
you will find times when there are too few satellites to observe - a minimum of four is 
required for three dimensional positioning. However, especially in polar areas, and in 
locations with obstructions to the signals, such as modern urban environments, it can pay 
to do some careful planning. Also, considering the cost of field operations, a small amount 
of time spent planning your window can be paid back many times over when the best 
results are desired.

A major feature of the Mission Planning for Windows software is its ability to use both the 
GPS and GLONASS satellite systems. As a general rule, when there are more satellites 
available, you will obtain better results in a faster time. With two constellations, the 
number of visible satellites at any one time is practically doubled. Coupled with the 
WinPrism for Windows post-processing suite, Mission Planning for Windows gives you a 
complete set of software to plan and process data from both systems.

Overview

Examining some of the elements of Mission Planning will give you a clearer picture of 
what is available in the program and will help you use it more effectively.

The Mission Planning Project

The basic work unit of Mission Planning is the project. Mission Planning allows you to 
work on one project at a time. Each project is identified by a unique name, and is stored on 
your computer’s hard disk as a Project File, with the extension *.prj. You may regard
project as a container for a number of sites. You should check the availability of sate
for each site in your project, since this will change with geographical location.

Mission Planning is supplied with USASITES.PRJ, which contains typical United Sta
cities as a sample project.
n 11
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You may create projects, open existing projects, and edit projects. When creating or 
opening a project your first task will be to select an appropriate site to begin planning.

Sites

In order to use Mission Planning properly, you must have a rough idea of where you 
are going to collect GPS/GLONASS data. The location where you set up your 
receiver is termed a site. It is quite possible to have many sites in a project.

Dilution of Precision (DOP)

One of the main factors you want to take into account when planning a project is the 
dilution of precision, or DOP. This is a measure of the geometrical strength of the 
solution you could obtain using a certain satellite configuration. Since the satellite 
constellation above each site is constantly changing over time, the DOP will also 
change. You should look at the plots of DOP available in Mission Planning to 
determine when the best time to observe will be - this will be your “window”.

The DOP value is unitless and depends on the number satellites available and t
relative locations in the sky. There are a number of varieties of DOP, including:

• PDOP—the dilution of precision of (3 Dimensional) position.
• TDOP—the dilution of precision of time.
• HDOP—the dilution of precision of horizontal positions.
• VDOP—the dilution of precision of vertical positions.
• GDOP—the geometric dilution of precision, a combination of the positio

and time dilution of precision.

You may choose the particular DOP that is closest to your needs, i.e., for three 
dimensional positioning, PDOP would be of interest, whereas if you are only 
interested in vertical positioning you should examine the variation in VDOP.

The Observation Window

The goal of Mission Planning for Windows software is to allow you to select the b
time to set up your receivers so that you can obtain the best results. Having set 
project, selected a site, chosen the appropriate satellites and defined an approp
almanac file, you should inspect the various views available to define the best tim
observe. This is called the observation window, or more simply the “window”. As
rule of thumb, a good window has at least four satellites available, and a PDOP o
than five.

The Almanac

The satellite location data are stored in a file called an almanac. Mission Plannin
Windows requires an almanac file in order to compute satellite positions. The 
Ashtech naming convention for such files is of the form ALMyy.ddd, where yy ar
Mission Planning User’s Guide
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the last two digits of the year and ddd represents the day of year. The Mission 
Planning program reads this file and calculates the satellite orbits and locations. You 
can select the directory, where MPW will look for almanac files.

 A current almanac is important for accurate planning. When an almanac is over 60 
days from the planning date (earlier or later), you will see a warning message 
indicating this fact. You can continue to use Mission Planning, but you should be 
aware that the information displayed is not current. Mission Planning automatically 
uses the latest almanac available, unless you have chosen previously to use the last 
used almanac in the Options dialog.

You can obtain a current almanac from an Ashtech receiver by using the Transfer 
module in the WinPrism for Windows program, selecting the Download screen 
followed by the Almanac option.

Printing

Mission Planning allows you to print the results of your planning. In the Project 
menu, are two printing options:

• Print Graph
• Print Table

Print Graph

This selection is only available if you have an open plot window. If you have mor
than one plot open, the graph plotted will be that of the selected plot window (this
be indicated by the window title bar being highlighted). To change the selected p
window simply click anywhere within the desired window. A plot of the graph sho
on the screen will be sent to your printer.

Print Table

This selection is only available if you have an open plot window. If you have mor
than one plot open, the table printed will be that of the selected plot window (this
be indicated by the window title bar being highlighted). To change the selected p
window simply click anywhere within the desired window. A table of values of the
selected plot window will be sent to your printer. For example, for the Satellite 
Availability window, a table of DOPs and the number of satellites against time is
printed.
n  13
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About Mission Planning

Selecting the About... option from the Help menu brings up the About dialog box.

This gives you the version of Mission Planning you are using and copyright 
information.

Exiting Mission Planning

To exit Mission Planning for Windows, either:

Select Exit from the Project menu.

or

Double-click on the system menu button of the main window.

If you have made changes to the current project you will be prompted to save them if 
desired.

 Figure 1.1: About dialog
Mission Planning User’s Guide
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Customer Support

If you have any problems or require further assistance, the Customer Support team 
can be reached through the following:

• telephone
• email
• Ashtech BBS system
• Internet 

Please refer to the documentation before contacting Customer Support. Many 
common problems are identified within the documentation and suggestions are 
offered for solving them.

Ashtech customer support:

Sunnyvale, California, USA

800 Number: 1-800-229-2400

Local Voice Line: (408) 524-1680

fax Line: (408) 524-1500

Email: support@ashtech.com

Ashtech Europe Ltd. Oxfordshire UK

TEL: 44 1 993 883 3533

fax : 44 1 993 883 3977

Solutions for Common Problems

• Check cables and power supplies. Many hardware problems are related
these simple problems.

• If the problem seems to be with your computer, re-boot it to clear the 
system's RAM memory.

• If you are experiencing receiver problems, power cycle the receiver or tr
different port.

• Verify the batteries are charged.
n  15
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If none of these suggestions solves the problem, contact the Customer Support team. 
To assist the Customer Support team, please ensure the following information is 
available:

Corporate Web Page

You can obtain data sheets, GPS information, application notes, and a variety of 
useful information from Ashtech’s Internet web page. In addition, you can acces
BBS through the web site, and locate additional support areas such as frequentl
asked questions and training previews. The Internet address is:   http://
www.ashtech.com

 Table 1.1: GPS Product Information 

Information Category Your actual numbers

Receiver model

Receiver serial #

Software version #

Software key serial #

Firmware version #

Options*

A clear, concise 
description of the 
problem.

* The firmware version # and options can be obtained using the $PASHQ,RID (receiver identification) 
command.
Mission Planning User’s Guide
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General

If your computer contains a modem and communications software, you can access 
information from Ashtech’s computer Bulletin Board System (BBS). Two data lines 
are available 24 hours a day, 7 days a week, except for short periods when the system 
is off-line for maintenance. The Ashtech BBS uses the TBBS BBS software and 
provides several important services. You can download a current almanac, get the 
status of the GPS satellites, get NANUS (Notices Advisory to Navstar Users), and 
look at solar and geomagnetic data from SESC (Space Environment Services Center) 
in Boulder, Colorado. On occasion, the BBS has been used to carry software updates 
and document files. 

The first time you call, you will be able to log on and browse for up to 30 minutes, but 
you will not be able to download. During this initial logon, you will be asked for 
identifying information and a password; anonymous callers will not be given access 
to the system. Remember exactly how you entered your name and how you spelled 
your password; write them on paper, they will be your entry into the system in the 
future. 

After you have logged on and registered, the SYSOP verifies your status as a 
customer, and establishes your security code commensurate with the hardware and 
software you are using. 

The BBS phone numbers are:

• Line 1 408-524-1527 2400 to 28800 baud
• Line 2 Automatic rollover 2400 to 14400 baud if line 1 is busy 

Parameters: N,8,1 (No parity, 8 bits, 1 stop bit, full duplex)
n  17



18 Mission Planning User’s Guide



 2

Project Management
Project Ma

P
roject M

anagem
ent
Starting Mission Planning

When installed with Prism for Windows, Mission Planning appears as a separate icon in 
the Prism for Windows Program Group.  Double clicking on it will execute the program.  
Alternatively,  Mission Planning may be executed from within Prism for Windows by 
clicking on the Planning icon in the Main Menu screen.  Once invoked, the main window 
of the program appears.

Table 2.1 describes the various components of this window.

 Figure 2.1: Mission Planning main window

 Table 2.1: Mission Planning main window

Component Description

Title Bar Displays the program name and the current open project.

Menu Bar Displays the available function menus.

Tool Bar Provides access to frequently used function. See the tool bar section for a list.

Time Control 
Bar

Defines date and time period of interest. Date fields are filled with the current 
date when Mission Planning is started.
nagement 19
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Creating a New Project

To create a new project, perform the following steps:

1. Select Project from the menu bar.  The choices on this menu deal with 
project creation and maintenance.

2. Select New... from the Project menu.  This brings up the Site Editor dialog 
box.

The project is initially named PROJXXXX.PRJ, with xxxx being a sequential 
number that is incremented every time a project is created.  The project name 
appears in the Mission Planning main window title bar. This name can be 
changes using the Save as function in the Project menu. 

Creating a New Site and Using the Site 
Editor

When you wither create a new project or open an existing project, mission planning 
brings up the Site Editor. The Site Editor allows a you to add or delete sites, or edit 
existing sites.

Status Bar Contains fields for the selected site names and location (if a site has been 
selected), the cut-off angle, and whether obstructions are on or off.

 Figure 2.2: Site Editor window

 Table 2.1: Mission Planning main window (continued)

Component Description
Mission Planning User’s Guide
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To create a new site:

1. Enter the site name (up to 20 characters).

2. Enter the optional site description.

3. Enter the site coordinates. This can be done one of two ways:

a. If you know the approximate coordinates of the site, type them into the 
latitude, longitude, and altitude fields.

b. If you do not know the approximate coordinated of the site, you can 
locate the site on a map and mission planning will devise the 
coordinates for you. Click on the map button located on the right hand 
side of the Site Editor. Use the mouse to click on the approximate site 
location. Click on the OK button.

4. Enter the difference between your local time system and GMT in the 
LOCAL TIME-GMT field. This will allow mission planning to display 
satellite visibility information in local time.

5. If you wish to add obstructions to your site, click on the obstruct button.

6. Once all the Site information is entered, click on the ADD button. This will 
add the new site to the List of Sites.

Sites that contain obstruction information will have a green # sign next to the site.

To edit a site:

1. Click on the desired site from the List of Sites.

2. Make any necessary changes in Site name, description, coordinates, 
obstructions, or local TIM-GMT time.

3. Once all changes have been entered, click on the replace button. The site will 
be updated with the new information.

Selecting a Site

Before any satellite visibility information can be displayed, mission planning must 
have a site location.

To select a site:

1. From the project menu, open a project file that contains a list of sites. This 
can either be a project file you have created of the Ashtech supplied 
USASITES.PRJ.

2. Click on the desired site from those available in the List of Sites.

3. Click on the Select button.
nagement 21
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4. The Site Editor automatically disappears and you are now in the main 
screen. The Site name chosen along with the Site coordinates we displayed 
in the status bar at the bottom of the screen.
Mission Planning User’s Guide
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Principles

Having opened a project and selected a site, you are now ready to proceed with planning 
your mission. There are a number of steps to follow:

Select the day which you plan to observe (see Planning Date and Time below).

Select the system and satellites you wish to use (see Setup, Satellite Configuration).

Select the most up-to-date almanac.

Select options available such as cut-off angles, and position mode (See Setup/Options).

Examine the appropriate plot(s) to determine the best window.

You may zoom in on a smaller time period by adjusting the arrows on the time bar (see 
Planning Date and Time). You will have an idea of how long you need observe, based on 
the needs of your project. You need to select a good window which is as long as your 
observation period, or better still, longer, since many unforeseen problems can occur in the 
field.

The Sky Plot shows a polar plot of the satellite locations and tracks over time.

Planning Date and Time

Once you have selected the site of interest, you should enter the date which you expect to 
observe on in the date entry field of the Time Control bar. When you first execute the 
Mission Planning program the date is the current date as reported by your computer.

When you start Mission Planning, the time bar is set for a 24-hour time interval. There are 
two buttons with arrows on them, one pointing right (indicating the beginning time) and 
one pointing left (indicating the end time). The red section of the time bar is the current 
time slot for the mission. 

You can adjust the time span to be viewed by sliding the arrow buttons in and out along 
the 24 hour time scale. To accept the time change you have selected, click outside the time 
bar region. This will update any plots that are present.

You have the capability to change the display to any planning date. However, since the 
satellite almanac data changes from time to time, planning more than 60 days beyond the 
 & Almanacs 23  
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almanac data may produce inaccurate information. If you select a planning day which 
is out of range in relation to your selected almanac data you’ll see the message:

The time slot applies to all sites in the project - it will not change if you select a 
different site in the project.

To change the starting time

Perform the following steps:

1. Click and hold down the left mouse button on the right facing arrow.

2. Drag the arrow button to the left or right on the scale until the point of th
arrow is at the correct time.

3. Release the mouse button. The selected time slot will change.

To change the ending time

Perform the following steps:

1. Click and hold down the right mouse button on the left facing arrow.

2. Drag the arrow button to the left or right on the scale until the point of th
arrow is at the correct time.

3. Release the mouse button. The selected time slot will change.

Note that you can slide one arrow past the other. This provides a time slot that wraps over the 
midnight point. For example if you slide the right-facing arrow to the 20-hour point and the left-
facing arrow to the 4-hour point, you schedule a time span from 20:00 to 04:00.

Time is always displayed as local time. The offset from GMT can be set in the S
Editor dialog. The offset is site specific.

 Figure 3.1: Old Almanac Warning Dialog
Mission Planning User’s Guide
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Selecting Satellites and the Almanac

The setup menu allows you to change several parameters such as the satellite 
configuration, the almanac used. The satellite cut-off angle, and the display mode.

Satellite Configuration

To bring up the Satellite Configuration dialog, select Satellite Configuration... from 
the Setup menu. The following window will appear:

In this screen you can define the following:

• The satellite system to be used.
• The individual satellites to be used.
• The directory where Mission Planning will look for almanac files (default

the executable directory).
• The almanac file to be used in this project.

There are two panels of satellites, one each for GPS and GLONASS. In these p
each satellite has a check box next to it. Additionally, there are two buttons at th
bottom of each panel to switch on/off all the satellites in a particular system. The
buttons are useful if you wish to quickly select or clear all the satellites in the pan

 Figure 3.2: Satellite Configuration window
 & Almanacs 25
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There is also a “System” group of check boxes at the bottom of the screen to sele
system to be used. To select which satellite system(s) you want to use perform 
following:

1. Check the GPS box in the “System” group if you want use GPS.

2. Check the GLONASS box in the “System” group if you want use 
GLONASS.

3. If you have a receiver and software capable of using both systems, it is 
to select both systems, since more satellites are always better.

To select individual satellites:

1. Click on the check box next the satellite. A checkmark indicates it is 
selected.

2. If a check does not appear it means that the system to which the satellit
belongs has been deselected. Check the appropriate box in the “System
group.

3. If there is a red line underneath the satellite number, then that satellite i
unhealthy according to the almanac. You may select unhealthy satellite,
be advised that your session will contain possibly bad date.

4. If the box is grayed out, there is no entry in the almanac for that satellite
it is not available.

The satellite selections you make in this dialog apply to all open window
For example if you have the Sky Plot window open and deselect all 
GLONASS satellites, when you click OK, the Sky Plot will automatically b
updated.

To select a different almanac:

1. If you need to change the path to the new almanac, click the Change Di
button. This will bring up a regular Windows Open File dialog in which yo
can change the drive and directory containing the new file.

2. Click OK to select the new path. If there are no almanac files in the direc
you will not be able to click OK - in this case click Cancel.

3. Click on the arrow to the right of the Almanac drop down combo box. A 
of available files will be presented.

4. Click on the almanac you wish to use.

The satellite panels will be updated to reflect the contents of the new file
For example if you change from an almanac containing only GPS satelli
to one containing GPS and GLONASS you will see the GLONASS satel
check boxes become checked.

5. To accept changes, select OK.

6. To cancel changes, select Cancel.
Mission Planning User’s Guide
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Options

To bring up the Options dialog, select Options... from the Setup menu. The following 
dialog will appear:

In this screen you can define

• Mode.
• The display time interval.
• The cut-off angle.
• Whether obstructions are on or off.
• To use the last used almanac automatically at start-up.

Positioning Mode

You can choose between 2-D and 3-D positioning modes. If you are solely intere
in horizontal positioning and are not concerned with height, you may choose 2-D
This option had more importance in the past when there were fewer satellites 
available and there were no receivers capable of simultaneous GPS and GLONA
data collection. Constraining the positioning mode to 2-D meant that you could w
with only three satellites, a sometimes common occurrence.   However, this shou
much less of a consideration now that there are always more than four satellites
view. The recommended selection is 3-D.

Display time

You may also select the time interval at which the DOP and availability values a
calculated. You have a choice between 5 and 15 minutes. The basic difference 
15 minute intervals allow quicker calculation of the DOPs. while 5 minutes is slo
but gives a better picture of how the satellite constellation changes over time wh
you are zoomed in on a small time span.

 Figure 3.3: Options window
 & Almanacs 27
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Cut-Off Angle

The cut off angle is the angle above the horizon below which you wish to ignore 
satellites. It is a good idea to have a value of at least 10 degrees here, since satellites at 
low angles are subject to high levels of atmospheric refraction and multipath.

Obstructions On/Off

There is a check box to apply or remove any obstructions you have defined for the 
current site. The obstructions are not destroyed if you deselect this box - they are 
merely ignored and can easily be restored by rechecking it.

Load Last Almanac

The final option in this dialog allows you to use the last used almanac the next time 
you start Mission Planning up. This overrides the default behavior of Mission 
Planning which is to load up the most recent almanac in the current directory.

Clicking OK will update all open windows with changes.

Clicking Cancel ignores changes.
Mission Planning User’s Guide
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Having selected a site and setting the desired options, you are now ready to view the 
Satellite plots to plan your mission.

Mission planning provides three different plots and graphs that you can examine. Each 
plot provides a different perspective on satellite visibility, location, and availability. All 
plots are accessed from the VIEW menu. The three plots that are available are:

• Satellite visibility plot that tells you when individual satellites are visible;
• The  DOP plot that shows a graph of the total number of satellites available 

the DOP values versus time, and;
• The SKY plot that display a polar plot of the satellite track as they cross the 

Which plot is most useful depends upon the individual. However, in general, the DOP
is the most helpful as the availability and strength of the geometry are usually the m
important factors in planning a mission. 

Satellite Visibility

To activate the Satellite Visibility window, select Satellite Visibility from the View men
This will bring up the following window:

 Figure 4.1: Satellite Visibility window
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This window contains a graph of when satellites are available. The time scale on the 
horizontal axis corresponds to the selected time span in the Time Control bar. Down 
the vertical axis are the satellite PRN numbers for the satellites you have selected in 
the Satellite Configuration window. Since Mission Planning works with both GPS 
and GLONASS, the satellite constellation is also shown in the main client area of the 
window. If you have selected both systems, there may be too many satellites too fit in 
the window vertically. In this case a vertical scroll bar becomes active on the right 
side of the screen. Use this to move up and down the list.

A colored bar to the right of the satellite ID number indicates when it is visible at the 
selected site. The bar colors are highly contrasted to allow easier separation of the 
satellites.

You will want to select a time period when there are most satellites available for an 
extended period. For any particular time you can find the number of satellites 
available by counting the number of bars crossing that time.

However, this window is most useful for detecting when individual satellites are 
visible. For example, if you are interested in GPS satellite 28 you can easily see it on 
this graph. A more useful view for seeing the total number of satellites available is the 
combined DOP/Satellite Availability plot, described next.

As you move the mouse over the window, you will see two fields in the status bar 
showing the time and the satellite ID number.
Mission Planning User’s Guide
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DOP Plot

To activate the DOP plot window select DOP Plot from the View menu. This will 
bring up the following window:

This shows a graph of the Dilution of Precision and the number of available satellites 
against time. The time scale on the horizontal axis is adjusted to correspond with the 
selected time span in the Time Control bar. There are a number of check boxes along 
the top of the window. PDOP and Satellite Availability are checked by default.

You will notice that the left vertical axis displays the DOP value, while the right axis 
displays the number of satellites available. Availability is always displayed in green, 
as indicated by the title on the availability axis scale. You may select to view any 
combination of DOP types by checking and unchecking the appropriate boxes. As a 
particular DOP is selected, a color key is added to the legend above the graph. Each 
DOP has a different color. For example, to display GDOP:

1. Move the mouse arrow to the GDOP box.

 Figure 4.2: DOP Plot window
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2. Click the GDOP box.

You will notice the graph is updated with GDOP, and the legend is updated 
above the graph. To remove GDOP, uncheck the box.

You should also notice that there is a general inverse correlation between the 
DOP value and the number of satellites available - the more satellites there 
are, the lower the value of DOP, and vice versa. To achieve the best results 
you should be looking for an extended period where the DOP value is low 
and the number of satellites is high. You can adjust your observation 
schedule to fit in with the best time. Note that the time axis is in local time.

As you move the mouse over the window, you will see two fields in the 
status bar showing the time and DOP value.

The satellite availability graph actually provides a different view of the same 
information as the Satellite Availability window. Most users find this 
window the easiest to use to find the best time to observe.

Sky Plot

To activate the Sky Plot window, select Sky Plot from the View menu. This will bring 
up the following window:

This graph shows a polar plot of the satellite tracks as they cross the sky. As in the 
Obstruction Editor screen, north is at the top, east at the right, etc. The figures around 

 Figure 4.3: Sky Plot window
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the edge indicate the bearing from north in 30 degree increments. The concentric 
circles indicate elevation above the horizon, from 0 degrees at the edge to 90 degrees 
(directly above the site) in the center.

You will see the track of each satellite plotted in contrasting colors - the colors 
correspond to those used in the Satellite Visibility window. The PRN numbers are 
also attached to each track. GPS satellites are indicated by yellow disks, while 
GLONASS satellites are shown by blue disks.

If a cut off angle is specified, a portion of the polar plot will be shaded above the 
horizon up to the cut off angle. No satellite tracks appear below this angle. In 
addition, if you have defined an obstruction for the site, and have selected to use it, it 
will appear as a shaded region.

As you move the mouse over the window, you will see two fields in the status bar 
showing the azimuth and elevation.

Arranging Plot Windows

Mission Planning follows the standard Windows Multiple Document Interface 
definition. Each plot you open is a separate window with its own system menu and 
minimize/maximize buttons. You may arrange and tile these windows using the 
Window item on the main window menu bar - you use this in the same way that you 
use the Window menu in the Windows 3.1 Program Manager. It can be useful to open 
the plots and tile them so that you see them side by side.
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